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Using System Image Manager to Automate 

Windows Vista Installations  
 

Objectives 
After completing this lab, you will be better able to: 

� Use Windows System Image Manager to create a distribution share 

� Use Windows System Image Manager to create a simple Unattend.XML 

file 

� Use Windows System Image Manager to create an advanced 

Unattend.XML file  

� Perform an unattended installation of Windows Vista 

Scenario 
Your organization has standardized on Windows Vista as its desktop platform.  

You are responsible for creating a standard image that will be distributed to all 

clients.  Once you have created the standard image it will be given to the 

distribution team who will be responsible for its deployment via a variety of 

methods including Windows Deployment Services (WDS), Image Based Setups 

(IBS), network & CD/DVD based installations. 

Prerequisites 
You should be familiar with the following products or technologies before you 

begin this lab.   

� Familiarity with Business Desktop Deployment 

Estimated Time to 
Complete This Lab 

 

60 Minutes 

Computer used in this Lab  DC1 - Domain Controller running Server 2003, Windows AIK, 

WDS 
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Exercise 1 
Creation of support infrastructure 
 

Scenario 
In this exercise you will use Windows System Image Manager (WSIM) to create a distribution share and then 

populate it with the support files required to perform a customized installation.  The machine that will act as the 

distribution server has Windows Server 2003 R2 installed and has been configured as a Domain Controller.  The 

WSIM is included in the Windows Automated Installation Kit (WAIK) 

 

Tasks Detailed Steps 

1. Install the Windows 

Automated 

Installation Kit 

 

Note: DC1 is initially 
logged on with the 
following credentials: 

Domain: Contoso 

Username: Administrator 

Password: P@ssw0rd 

Note: The Windows System Image Manager tool is included in the Windows 
Automated Installation Kit (Windows AIK).  In this task you will use the WSIM to 
create a distribution share that will be used to store the additional components that 
will be installed as part of the automated installation of Windows Vista 

a. On the Start menu, click All Programs, then click Microsoft Windows AIK, and 

then click Windows System Image Manager. 

b. From the Windows System Image Manager (WSIM) console, right click Select a 

Distribution Share and then click Create Distribution Share. 

c. In the Create a Distribution Share dialog box, enter 

E:\Sources\Distributionshare and click Open. 

d. Expand the E:\Sources\Distributionshare entry in the Distribution Share pane 

and confirm that the following folders have been created: 

 

 $OEM$ Folders 

 Out-of-Box Drivers 

 Packages 

Note: WSIM requires at least one of the above folders to be present in order to 
recognize a folder as a valid distribution share. 

2. Populate the 

Distribution Share 

with Windows Vista 

build images & 

support files 

Note: Now that you have created the basic distribution share structure, you need to 
populate it with the Windows Vista source files and the support files that you will use 
as part of the build process.  For this task, a 3rd party driver and a hotfix will be added 
to the distribution share.  In a later task, you will modify the answer file to include 
these items.  Once the Distribution share has been populated, you will enable it as a 
network share and then open it using WSIM, 

a. Using Windows Explorer create a folder named E:\DistributionShare then copy 

the contents of the E:\Sources\distributionshare folder to E:\DistributionShare 

b. Using Windows Explorer copy the contents of the E:\sources\Out-of-Box 

drivers folder to E:\DistributionShare\Out-of-Box Drivers 

c. Using Windows Explorer copy the contents of the E:\sources\Packages folder to 

E:\DistributionShare\Packages 

d. Using Windows Explorer share the E:\DistributionShare\ folder as Build$ 

leaving the permissions at their default values.  Close Windows Explorer. 

e. From the Windows System Image Manager console, click File then Close 

Distribution Share 

f. From the Windows System Image Manager console, click File then Select 

Distribution Share…, then enter \\dc1\build$ and click Open. 
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Tasks Detailed Steps 

Note: Step f is performed so that WSIM will populate the answer file with the network 
path for drivers & packages that are added to the build.  The share was created as a 
hidden share (build$) to minimize the likelihood of network users browsing to the 
share. 
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Exercise 2 
Using Windows System Image Manager to create a simple 
Unattend.XML answer file 
 

Scenario 
In this exercise you will use Windows System Image Manager (WSIM) to create a simple unattend.xml file that 

could be used to perform a basic Windows Vista installation.  This file will include the minimum responses required 

to install Windows Vista but will not install additional applications, perform custom actions or include 3
rd

 party 

driver paths. 

The screenshot below identifies the different screen elements that make up the WSIM tool.  As you progress through 

the lab, this can be used to identify the different panes that are referenced in each step. 

 

 

 

Tasks Detailed Steps 

1. Using Windows 

System Image 

Manager to create 

and customize an 

unattend.xml 

 

Note: Now that the core support components have been created in the environment, 
you will use WSIM to create an answer file.  For Windows Vista, the multiple answer 
files that were used in Windows XP have been replaced by a single XML file.  While it 
is possible to use a text editor such as Notepad to create the XML file, WSIM ensures 
that the answer file is formatted correctly and will validate it to ensure that all entries 
have values as appropriate. 

a. In the Microsoft System Image Manager Window, click File, and then click 

New Answer File, when prompted to open a Windows image, click Yes. 

b. In the Select a Windows image dialogue box, browse to E:\Sources\install.wim 

and click Open. 

c. In the Windows System Image Manager pop up question box, click Yes to create 

a new catalog file.  This process will take approximately two minutes. 
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Tasks Detailed Steps 

2. Create a 12Gb Disk 

Partition 
Note: Now that the basic XML file has been created, you will modify the answer to 
create a 12Gb partition into which to install Vista  
a. In the Windows Image pane, expand Windows Vista 

ENTERPRISE\Components\ x86_Microsoft-Windows-

Setup_6.0.5384.4_neutral\DiskConfiguration. 

b. Right-Click Disk and select Add Setting to Pass 1 windowsPE 

c. In the Answer File pane, select Disk then in the Disk Properties pane enter the 

following values: 

 

DiskID  0 

WillWipeDisk  true 

d. In the Answer File pane, expand Disk and then right click CreatePartitions and 

click Insert New CreatePartition 

e. In the CreatePartition Properties pane enter the following values: 

 

Order   1 

Size   12000 

Type   Primary 

Note: 12Gb is being used due to the size of the virtual disks in use 

3. Format the new 

partition with NTFS 

and assign a drive 

letter & label 
 

Note: Now that the partition has been created, you will create an entry that will 
format it and assign it a drive letter. 
a. In the Answer File pane, right click ModifyPartitions and click Insert New 

ModifyPartition 

b. In the ModifyPartition Properties pane enter the following values: 

 

Active  true 

Extend  false 

Format  NTFS 

Label  Vista 

Letter   C 

      Order  1 

      PartitionID 1 

4. Specify the location 

to install Windows 
 

Note: With the partition created & formatted, an entry is now required so that 
Windows Vista will be installed to the newly created drive. 
a. In the Windows Image pane, expand Components\x86_Microsoft-Windows-

Setup_6.0.5384.4_neutral\ImageInstall\OSImage. 

b. Right click InstallTo and select Add Setting to Pass 1 windowsPE 

c. In the InstallTo Properties pane enter the following values: 

 

DiskID  0 

PartitionID 1 

5. Enter registration 

data, computername 

and product key  
 

Note: The basic goal of creating an answer file is to minimize the interaction required 
to install Windows.  In this step you will create entries for the user name, organization 
name, computer name and the product key that will be used by the setup process. 
a. In the Windows Image pane, expand Components, x86_Microsoft-Windows-

Setup_6.0.5384.4__neutral 

b. Right click UserData  and select Add Setting to Pass 1 windowsPE 
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Tasks Detailed Steps 

c. In the UserData Properties pane enter the following values: 

 

AcceptEula true 

FullName Northern Sales 

Organization NorthWind Traders 

d. In the Answer File pane, expand UserData, and then select ProductKey 

e. In the ProductKey Properties pane enter the following values: 

 

Key  XXX-ABCD-DEFGH-12345-VWXYZ 

WillShowUI OnError 

6. Assign a Password to 

the Default 

Administrator 

Account 
 

Note: As part of the basic security practices for your organization, all machines must 
have a complex password assigned to the local administrator account.  In this task you 
will assign a password to the administrator account.  
a. In the Windows Image pane, expand x86_Microsoft-Windows-Shell-

Setup_6.0.5384.4_neutral.  Right-click UserAccounts and select Add Setting to 

Pass 7 oobeSystem 

b. In the Answer File section, expand UserAccounts, and then select 

AdministratorPassword 

c. In the UserAccount Properties pane, next to AdministratorPassword enter 

P@ssw0rd. 

Note: Windows System Image Manager will encrypt the Administrator’s password in 
the unattend.XML file  We will look at the encrypted password in an upcoming 
exercise. 

d. Under the Answer File pane, right-click DomainAccounts and then click delete.   

e. Right-click LocalAccounts and then click Delete.  These sections are used to add 

Domain User Accounts and Local User Accounts into the User Profiles sections of 

Windows Vista after the completed installation.  We will not be using these 

sections in this lab. 

7. Generate and 

Validate the Answer 

File.XML  
 

Note: You have now entered the basic settings required to perform an unattended 
setup of Windows Vista.  WSIM will now be used to validate the file.  Validation 
confirms that the settings present in the file can be applied to the Windows image for 
which the answer file has been built. 
a. On the WSIM menu bar, select Tools, Validate Answer File, then confirm that 

the No warnings or errors message is displayed in the Messages pane. 

b. On the File menu, select Save Answer File.  In the File name box type 

C:\unattend.  Then click Save. 

c. Close Windows System Image Manager.  Open C:\unattend XML using 

Notepad and view its contents.  As the answer file is stored as standard XML file, 

any editor capable of saving files in plain text can be used to manipulate and create 

answer files. While it is possible to use of text editors, it is recommended that 

WSIM be used as it will validate the structure of the file and confirm that all 

entries have values where required. 

Note: Scroll down to the section marked <UserAccounts> and notice the line beneath 
<AdministratorPassword> has a value of a very long string.  This is the 
administrator’s password, encrypted.  Notice the line beneath this password reads 
<PlainText>False</PlainText>.   

d. After viewing the unattend.XML file, close Notepad, and close Windows 

Explorer.  

 Note:  Do not save any changes that you may have inadvertently made. 
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Exercise 3 
Using Windows System Image Manager to create an 
advanced Unattend.XML answer file 
 

Scenario 
In this exercise you will use Windows System Image Manager (WSIM) to further extend the simple unattend.xml 

file created in the previous exercise so that it will remove the standard games that ship with Vista, install a hotfix, 

place a custom item in the Internet Explorer Favorites, modify the Internet Explorer Home page, execute a custom 

command and specify a path to locate 3
rd

 party drivers 

 

Tasks Detailed Steps 

1. Using Windows 

System Image 

Manager to open and 

customize an existing 

unattend.xml 

Note: After reviewing the results of an installation performed using the answer file 
you created in the previous exercise, you have decided to further customize the build.  
In order to do this you will use WSIM to open the existing answer file and then 
through the addition of additional entries, modify the standard installation to reflect 
the needs of your organization. 

a. On the Start menu, click All Programs, Microsoft Windows AIK, Windows 

System Image Manager 

b. In the Microsoft Image Manager Window, click File, and then click Open 

Answer File, then select C:\Unattend.xml, and click Open 

2. Customize the 

installations by 

disabling the 

standard games that 

are included in a 

standard installation. 
 

Note: The call center manager has requested that machines deployed in her area do 
not contain the standard windows games as she has noticed a number of staff using 
these programs for extended periods of time.  In order to meet this requirement, you 
will modify the settings for the Windows Foundation Package so that the games are 
not installed. 
a. In the Windows Image pane, expand Windows Vista 

ENTERPRISE\Packages\Foundation. 

b. Right-click x86_Microsoft-Windows-Foundation-Package_6.0.5384.4_ and 

select Add to Answer File. 

c. In the Windows Foundation Properties pane, expand Inbox Games and ensure 

the following Values: 

 

Chess   Disabled 

FreeCell                        Disabled 

Hearts   Disabled 

InboxGames  Disabled 

Minesweeper  Disabled 

PurblePlace  Disabled 

Shanghai                       Disabled  

      Solitaire                        Disabled 

      SpiderSolitaire  Disabled 

3. Add 3
rd

 party drivers 

to the Vista 

installation 

Note: As part of the Windows Vista Deployment project, you have been evaluating a 
number of new laptops from prospective vendors.  Some of the laptops provided to you 
are preproduction samples that include a new type of wireless network card.  The 
vendors have provided you with a driver for these cards as they are not included in the 
standard Windows Vista build.   
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Tasks Detailed Steps 

 
In this task, you add an entry to the answer file so that Windows setup will query the 
distribution share when it is attempting to locate drivers for new hardware. 

a. In the Distribution Share pane, expand the \\dc1\build$ node then right click on 

Out-of-Box Drivers and click Add Driver Path to Pass 5 auditSystem 

Note: The wireless driver has already been placed into this folder.  If the drivers are 
also required during the initial WinPE boot, repeat the above step and add the setting 
to Pass 1 windowsPE 

4. Customize the 

installation of 

Internet Explorer to 

add a Home Page 

and a Favorites Link 
 

Note: The next task on your list of customizations is to set the default home page for 
Internet Explorer to be your corporate website and to create a favorite for the 
Windows Vista webpage. 

a. In the Windows Image pane, expand Windows Vista 

ENTERPRISE\Components\x86_Microsoft-Windows-IE-

InternetExplorer_6.0.5384.4_nuetral .  

b. Right-Click x86_Microsoft-Windows-InternetExplorer_6.0.5384.4_nuetral and 

select Add Setting to Pass 4 specialize.   

c. In the Microsoft-Windows-IE-InternetExplorer Properties pane enter the 

following values: 

 

Home_Page  http://www.nwtraders.com 

CompanyName NorthWind Traders 

IEWelcomeMSG false 

Note: If these values are grayed out and cannot be changed, then expand 
x86_Microsoft-Windows-IE-InternetExplorer_6.0.5384.4_nuetral in the Answer File 
section 

d. In the Answer File pane, expand 4 specialize, x86_Microsoft…, FavoritesList 

e. Right click FavoritesList and click Insert New FavoriteItem 

f. In the FavoritesList Properties pane enter the following values: 

 

FavTitle  Microsoft Windows Vista 

FavURL  http://www.windowsvista.com 

5. Add hotfixes to the 

Vista installation 
 

Note: Maintaining a secure baseline for all the machines in your environment is an 
essential component of your organizations security strategy.  An essential part of the 
secure baseline is that all machines have the appropriate hotfixes installed.  In this 
task, you will modify the answer file so that the hotfix that you added to the 
distribution share in an earlier task is now installed as part of the build process. 

a. In the Distribution Share pane, expand the \\dc1\build$\Packages node then right 

click on Hotfix and click Add to Answer File 

6. Add a Command to 

run defrag.exe the 

first time a user logs 

on 

Note: The final customization that you will perform is to automatically launch the disk 
defragmentation tool the first time a user logs on. In this task, you are going to 
populate an entry for the oobeSystem. OOBE is an acronym for Out Of the Box 

Experience and refers to the processes that are launched the first time a user logs on 
to workstation after it has been built. 
a. On the Insert menu, expand Synchronous Command then click Pass 7 

oobeSystem 

b. In the Create Synchronous Command dialogue box, type defrag.exe and then 

click OK. 

7. Generate and 

Validate the Answer 
Note: With the addition of the additional settings to the answer file, you want to 
confirm that the answer file is still valid. In a repeat of the earlier task where you 
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File.XML  
 

validated the basic answer file, you will now use WSIM to validate the file.   

Note:  This exercise has been deliberately written so that the file will fail validation. 
a. On the WSIM menu bar, select Tools, Validate Answer File. Then monitor the 

Messages pane for errors. A couple of errors and warnings will be generated.  

Double-click on the error that says The key FavID of list FavoriteItem must 

have a value.  In the Properties section, enter 1 as the value. 

b. In the Messages section double-click the error that reads Configure action 

specified for the package but no Windows features have been selected.  This is 

because we added the package to verify games have been disabled, but did not 

modify any properties. 

c. In the Answer File section, right-click Foundation and then click delete.  Click 

Yes to confim. 

d. In the Answer File pane, expand Components, 5 auditSystem, x86_Microsoft-

Windows…..,DriverPaths, PathAndCredentials…, and click Credentials. 

e. In the Credentials Properties pane, enter the following values: 

Domain:                        Contoso 

Password:  P@ssw0rd 

Username:  Administrator 

f. On the WSIM menu bar, select Tools, Validate Answer File, then confirm that 

the No error messages are displayed in the Messages pane.  You will see a few 

warnings because we did not modify every property of every item added. 

g. On the File menu, select Save Answer File As.  In the File name box type 

C:\advunattend.  Then click Save. 

Note: You would normally name this answer file autounattend.xml.  When you put the 
Windows Vista DVD in your DVD–ROM drive, it will automatically look for a file 
called autounattend.xml in all media and removable media.  If you call it anything 
else, you will have to point to it during installation. 

h. Close Windows System Image Manager. 

 


